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RELEASE NOTES

INTRODUCTION

WebRatio BPM Platform is a powerful development environment that supports
Business Analysts in building an application that manages their business process
through a BPM engine. Let's look at the main functionalities of this product re-

lease.
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GENERATE AND RUN ON CLOUD WIZARD

GENERATE AND RUN ON CLOUD WIZARD

The user experience of the “Generate and Run on Cloud” option has been
improved introducing a wizard. The wizard briefly explains which are the actions
operated by the tool; it takes also into account also the cloud database
management so that you can really run your application with a single click. The
wizard is composed by three steps:

1. Free Cloud Account Provisioning. WebRatio Platform prepares the free
cloud account that hosts your application.

|s*| Generate and Run on Cloud O X
Free Cloud Account Provisioning a
" .
Your free cloud account is going to be prepared.
This operation may take several minutes, Press Next to proceed.
< Back Next > Finish Cancel

2. Cloud Database Synchronization. WebRatio Platform aligns the
database of your free cloud account with the latest changes done on the

Domain Model.

|s*| Generate and Run on Cloud a X
Cloud Database Synchronization “
l. .
Your cloud database is going te be aligned with the latest changes.
This operation may take several minutes. Press Next to proceed.
Back Next > Finish Cancel

3. Application Deployment. WebRatio Platform generates and deploys the
application on your free cloud account.
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|s*| Generate and Run on Cloud O X
Application Deployment “
Your application is going to be deployed on cloud.
This operation may take several minutes. Press Finish to proceed.

< Back Mets | Finsh || Cancel

ACTION DEFINITION MODELING IMPROVEMENTS

The flows contained in an action definition have been restyled to improve

model readability.

_>|

[D] Success Port

md

r Login

S

’ +
Internal Error«‘ @

[D] Error Port
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BPM BuILD CONFIGURATIONS

BPM BuILD CONFIGURATIONS

You can now create build configurations both for deploying the BPMN Engine
and for deploying the Processes. You can choose whether to deploy your
BPMN Engine on premises or in the cloud, using one of the configurations

shown in the image below.

|&*| Build Configurations X
Create. manage. and run configurations - ‘

| v | Configure launch settings from this dialog:

| B 5

| - Press the 'New' button ...ion of the selected type.

’»j BPM Engine - Local - Press the 'Duplicate’ b...e selected configuration.
£ BPM Engine - OpenShift

&3 BPM Engine - WebRatio Cloud
“% BPM Processes - Press the 'Filter' butte...nfigure filtering options.

- Press the 'Delete’ butt...e selected configuration.

- Edit or view an existing ...figuration by selecting it.

Cenfigure launch perspective settings from the
‘Perspectives’ preference page.

Filter matched 4 of 9 items

G Y .
\L7) Build Close

You can also build a set of BPM Processes in order to get a process archive file
(PAR) and upload it on a running BPMN Engine. The build configuration allows
you to select which are the business process you want to include in the archive
(see image below) and to specify which is the BPM Engine into which you want

to upload the archive.
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Name: | ExpenseReport - BPM Processes
:’ Modeﬂ Ei Tasks) A
Project
I ExpenseReport l IBrowse...]
Processes
] ExpenseReport
| Select All | | Deselect All |
| Apply J l Rﬂi’eﬂ: [ [Reload from Projectl
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BPM DRIVEN MAIL NOTIFICATIONS

BPM DRIVEN MAIL NOTIFICATIONS

You can now specify in the business process whether the assignee of a task
should be notified by email about the new activity. You just have to enable the
“Mail” option in the Notification section of the Properties View. You can decide
whether to set the notification on the entire lane or on a specific sequence flow.
You can see a preview of the available properties in the following image.

'] Properties 52 [ Overview| 2 v = 0
= [=] Employee [lanel]
= Mail 0
Mail Message | New queued activity: ${taskName} in process ${proc|E8

You can also set the SMTP server used to send Mail Notifications, filling in the
dedicated properties in the BPMN project.
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TASK POLICIES

You can now specify on a User Task which is the policy to apply to assign the
task to a specific user/role involved in the business process: “Distribution
Policy”. Moreover you can also set how the business process must behave when
a user releases a task he was working on: “Leave Policy”. For each policy you
have several options available. Read below for further information.

Distribution Policy

e Allocate to First User in Lane: the activity is assigned to the user who
completed a task in the lane for the very first time.

e Offer to All: the activity is made available to all the users belonging to
roles able to access the lane.

e Offer to Previous Role: a backward search is performed on the users
who completed previous tasks, starting from the last one; if the user's
role is also associated with the current lane, then the activity is made
available to all the users belonging to such role.

e Allocate to Previous User: a backward search is performed on the users
who completed previous tasks, starting from the last one; if the user
belongs to a role associated with the current lane, then the activity is
assigned to such user.

e Allocate to One (Balanced): the activity is assigned to the least busy
user belonging to a role associated with the current lane.

Leave Policy
e Reset: the activity status remains active but the activity is released from

the current user restoring the assignment information as the activity is
ready.

e Offer to All: the activity is released from the current user and is made
available to all the users belonging to roles able to access the lane.

e Offer to Role: the activity is released from the current user and is made
available to all the users belonging to the same role of the current user.

e Reapply Distribution: the activity is released from the current user and
the distribution policy is executed to decide the new assignee.
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IMPORT & EXPORT OF BPM PROCESSES

IMPORT & EXPORT OF BPM PROCESSES

You can now import and export BPM processes using the XPDL 2.1 and/or
XPDL 2.2 standard notation. You just have to select from the main menu the
options File -> Import or File -> Export and select the target format.

|s*| Export O X

Select /‘
Export a Process as XPDL 2.1 notation. I g § l

Select an export destination:

type filter text

= General
v (= BPMN

78 XML Process Definition Language 2.1
22 XML Process Definition Language 2.2

= Install

= Java

(= Plug-in Development

(== Run/Debug

= Team

(= Other

(’?/1 < Back Next > Finish Cancel
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REST API IMPROVEMENTS

Definition Services

You can now retrieve the live process definitions and signal definitions using
two dedicated methods. These methods can be invoked only by bpm process

administrators.

Definition Services Show/Hide  List Operations = Expand Operations
(<38l /process-definitions Get Process Definitions

(c3gll /signal-definitions Get Signal Definitions

History Services

All executed processes are archived in a history when they are completed. You
can now use a set of dedicated REST APIs methods in order to query the
process history. You can see in the following image which are the available

methods.

HiStOl’y Services Show/Hide | List Operations = Expand Operations
ﬂ /historic-tasks/{taskld} Get Historic Task
ﬂ /historic-processes/{processld} Get Historic Process
/historic-processes/{processld}/tasks Get Historic Process Tasks
ﬂ /historic-processes Get Historic Processes

Process Archives Services

You can now deploy the generated processes in an existing BPM Engine using
the dedicated REST APIs method available. In this way it's possible to update
the business processes definitions without shutting down the BPM Engine.
Every time a new deploy is done, the business process definitions are
automatically versioned by the BPM Engine.

Process Archive Services Show/Hide  List Operations = Expand Operations
ﬂ /process-archives/{processArchiveld} Upload a Process Archive
/process-archives Upload a Process Archive

/process-archives Upload a Process Archive
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WADL DEFINITION

Process Services Improvements

You can now throw signals and messages from the BPMN Engine using the two
new available methods.

Process Services Show/Hide = List Operations = Expand Operations
/processes/{processld} Get Process
/processes Start Process
/processes/{processld}/diagram Get Process Diagram
Lol /events/signals Send Broadcast Signal
GO /events/message Send Broadcast Message
WADL DEFINITION

WebRatio BPM Platform provides the additional WADL representation of the
engine’s API, that is published on the dedicated URL
(http://<host>:<port>/<application-name>/wadl).
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FIXED IN 8.5.5

Fixed the link to the Release Notes 8.5 document in the Learning Center
page.

FIXED IN 8.5.3

Improved the Find Model Problem command on BPMN projects. Now, a
check is also performed for the source database of the BPMN Engine
defined in the Project node, so that if the database is not set in the
property, it is reported as an error.

FIXED IN 8.5.2

Fixed the generation process of BPMN projects. Now, when you
generate and run on cloud a BPMN project to all bpm engine tables,
created for the database, they will be assigned the “bpm_" prefix to
discriminate from tables used in other projects deployed on the cloud.

Solved a problem related to the Derby database used in a BPMN project
that caused an error when you call the register service.

In a BPMN project, when you select the database in the Properties View
of the Project tab, the selected schema is now correctly shown on the
referenced BPM engine database.

Fixed the usability of the Swagger page for a BPMN project. Now, the
first time you expand a method node, e.g. login method, the swagger
page is not refreshed.
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FIXED IN 8.5.1

FIXED IN 8.5.1

e Fixed a problem of the Cloud Account View that prevented the user from
seeing the information of an Openshift application. Now when you have
more than one application in your Openshift account, you can correctly
see the information of each application.

e The Authorization field in the swagger page is now preloaded with the
current logged in user. In this way it's easiest to execute the REST APIs
methods.

e Now when a task is created, the notification message will be sent to the
user that is the owner of this task, and to all users that have the same
role belonging to the task. If neither a user nor a role has been set, the
notification is sent to all users having visibility on the created task.

FIXED IN 8.5.0

e When on an Intermediate Catching Timer Event is added a trigger, in the
Outline View this trigger is now properly shown as a child of the event.

e A limitation has been introduced for an added trigger to an Intermediate
Catching Timer. A trigger can have “Specific Date” or “Relative Time" as
the schedule policy.

e Solved a problem that caused an error when you generate a BPMN
project, which is shared on a CVS repository.
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OLDER RELEASES

Here you can find the release notes of previous WebRatio Mobile Platform

releases:

e WebRatio BPM Platform 8.4 Release Notes

SYSTEM REQUIREMENTS

WebRatio Development Platform
Operating System
e Microsoft Windows Vista or higher, 64 bit
e Linux, 64 bit
o Mac OSX 10.7 (Lion) or higher, 64 bit

Installing WebRatio Development Platform also requires:

e Disk Space: 600 MB
e RAM: 4 GB minimum, suggested is 8 GB
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